Upper Brushy Creek GeoHMS model development

[bookmark: _GoBack]By Dean Djokic, Environmental Systems Research Institute, Redlands, CA., March 2012
Generating DEM from terrain dataset and Arc Hydro preprocessing
This section covers most of the exercise 2.I in the H&H class materials.  It is the preliminary work on getting the good DEM and its derivatives as foundation for development of GeoHMS model.
1) Generate “raw” DEM from terrain dataset (using cleaned terrain dataset with enforced breakline).
Executing: TerrainToRaster newterrain_brushy C:\Public\Erika\Layers\demcln10 FLOAT LINEAR "CELLSIZE 10" 0
Start Time: Thu Feb 16 21:42:51 2012
Succeeded at Thu Feb 16 21:57:27 2012 (Elapsed Time: 14 minutes 36 seconds)

2) Fill sinks.  The flow direction developed on the initial DEM derived from terrain dataset had sinks, so filling was needed.  After filling, fdr was run again.  The paths did not match the digitized lines (neither Flowpaths provided by Ruth nor stream2D by Erika), indicating the need for stream burning.
Executing: FillSinks demcln10 C:\Public\Erika\Layers\demfcln10 # # ISSINK_NO
Start Time: Thu Feb 16 22:00:44 2012
Succeeded at Thu Feb 16 22:01:00 2012 (Elapsed Time: 16.00 seconds)

3) Burn streams.  Streams provided by Ruth were burned in (“Streams” as feature class in brushycreek_data0.gdb).  Flow direction on the reconditioned DEM still had sinks (introduced by stream burning). 
Executing: DEMReconditioning demfcln10 Streams 5 10 1000 C:\Public\Erika\Layers\demfacln10 NEGATIVE_NO
Start Time: Thu Feb 16 22:02:31 2012
Making buffer constant grid ..
Making smooth constant grid ..
Making sharp constant grid ..
Computing smooth drop/raise grid ..
Computing vector distance grid ..
Computing vector allocation grid ..
Computing elevation grid outside of the buffer ..
Computing buffer distance grid ..
Computing buffer allocation grid ..
Computing smooth elevation grid ..
Computing sharp drop/raise grid ..
Computing interpolated elevation grid ..
The resulting Agree DEM contains negative elevation values.
Succeeded at Thu Feb 16 22:03:36 2012 (Elapsed Time: 1 minutes 5 seconds)


4) Fill sinks (again).  Need to fill sinks again to get rid of the sinks in the streams introduced by the agree.
Executing: FillSinks demfacln10 C:\Public\Erika\Layers\demfafcln10 # # ISSINK_NO
Start Time: Thu Feb 16 22:04:14 2012
Succeeded at Thu Feb 16 22:05:04 2012 (Elapsed Time: 50.00 seconds)

5) Flow direction
Executing: FlowDirection demfafcln10 C:\Public\Erika\Layers\fdrfafcln10 #
Start Time: Thu Feb 16 22:06:01 2012
Succeeded at Thu Feb 16 22:06:15 2012 (Elapsed Time: 14.00 seconds)

6) Flow accumulation
Executing: FlowAccumulation fdrfafcln10 C:\Public\Erika\Layers\facfafcln10
Start Time: Thu Feb 16 22:06:57 2012
Succeeded at Thu Feb 16 22:09:26 2012 (Elapsed Time: 2 minutes 29 seconds)

7) Stream definition.  Use threshold of 150,000 cells (~1.40 km2).  It is just a nice round number.  Include the threshold (“150K”) in the name of subsequent layers being generated.
Executing: StreamDefinition facfafcln10 150000 C:\Public\Erika\Layers\Str150k 1.393551
Start Time: Thu Feb 16 22:10:14 2012
Succeeded at Thu Feb 16 22:10:25 2012 (Elapsed Time: 11.00 seconds)

8) Stream segmentation.  It generates 76 stream segments.  That is good number of segments (not too big, not too small).
Executing: StreamSegmentation Str150k fdrfafcln10 C:\Public\Erika\Layers\StrLnk150k # #
Start Time: Thu Feb 16 22:12:37 2012
Succeeded at Thu Feb 16 22:12:40 2012 (Elapsed Time: 3.00 seconds)

9) Catchment grid delineation
Executing: CatchmentGridDelineation fdrfafcln10 StrLnk150k C:\Public\Erika\Layers\Cat150k
Start Time: Thu Feb 16 22:13:23 2012
Succeeded at Thu Feb 16 22:14:00 2012 (Elapsed Time: 37.00 seconds)

10) Catchment polygon processing
Executing: CatchmentPolyProcessing Cat150k C:\Public\Erika\brushy.gdb\Layers\Catchment150k
Start Time: Thu Feb 16 22:14:32 2012
Converting grid to polygons...
Dissolving catchments...
Assigning HydroIDs...
Populating GridIDs...
Deleting Grid_Code...
Building index on HydroID...
Building index on GridID...
Succeeded at Thu Feb 16 22:14:43 2012 (Elapsed Time: 11.00 seconds)

11) Drainage line processing
Executing: DrainageLineProcessing StrLnk150k fdrfafcln10 C:\Public\Erika\brushy.gdb\Layers\DrainageLine150k
Start Time: Thu Feb 16 22:15:23 2012
Performing StreamToFeature...
Copying feature class...
Cleaning up streams...
Cleaning stream features ..
Adding HydroID and GridID fields...
Assigning HydroIDs to Drainage Line features...
Populating GridID...
Deleting Grid_Code field...
Building index on HydroID. dt = 0.44s
Building index on GridID. dt=0.42s
Populating NextDownID. dt=11.99s
Succeeded at Thu Feb 16 22:15:44 2012 (Elapsed Time: 21.00 seconds)

12) Adjoint catchment processing
Executing: AdjointCatchment DrainageLine150k Catchment150k C:\Public\Erika\brushy.gdb\Layers\AdjointCatchment150k
Start Time: Thu Feb 16 22:16:31 2012
Creating table view of DrainageLine input ...
Creating join between DrainageLine and Catchment using GridID/GridID
Populating DrainID field in Drainage Line
Removing Join between Drainage Line and Catchment
Creating table view of Catchment input ...
Creating join between Catchment and Drainage Line using GridID/GridID
Populating NextDownID in Catchment with HydroID of associated NextDown Drainage Line
Removing Join between Catchment and Drainage Line
Creating join between Catchment and Drainage Line using NextDownID/HydroID
Populating NextDownID in Catchment with HydroID of associated NextDown Catchment
Removing Join between Catchment and Drainage Line
Deleting Drainage Line View
Deleting Catchment View
Generating adjoint catchments...
Pass 1: 39features processed, 37 remaining. dt=0.10s dtTotal=0.20s
Pass 2: 47features processed, 29 remaining. dt=0.55s dtTotal=0.75s
Pass 3: 54features processed, 22 remaining. dt=0.66s dtTotal=1.41s
Pass 4: 60features processed, 16 remaining. dt=0.56s dtTotal=1.97s
Pass 5: 69features processed, 7 remaining. dt=1.69s dtTotal=3.65s
Pass 6: 70features processed, 6 remaining. dt=0.11s dtTotal=3.76s
Pass 7: 71features processed, 5 remaining. dt=0.12s dtTotal=3.88s
Pass 8: 72features processed, 4 remaining. dt=0.13s dtTotal=4.01s
Pass 9: 73features processed, 3 remaining. dt=0.14s dtTotal=4.16s
Pass 10: 74features processed, 2 remaining. dt=0.15s dtTotal=4.31s
Pass 11: 76features processed, 0 remaining. dt=0.60s dtTotal=4.91s
Assigning HydroIDs...
Accumulate shapes completed successfully.
Start: 2/16/2012 10:16:35 PM End: 2/16/2012 10:16:40 PM

Number of features processed: 76
Number of loops: 11
Traced Layer: Catchment150k
Source Layer:Catchment150k
Target Layer:AdjointCatchment150k
Number of source features not aggregated: 0
Total merge processing Time: 4.94s 0.001 hrs.
Update river order time: 0.08s
Total Processing time: 5.03s 0.001 hrs.
Succeeded at Thu Feb 16 22:16:45 2012 (Elapsed Time: 14.00 seconds)

Development of GeoHMS model layout
This section covers most of the exercise 6.I and II in the H&H class materials.  It is the preliminary work on getting the good DEM and its derivatives as foundation for development of GeoHMS model.
1) Run GeoHMS “Project Setup -> Start New Project” function.
a. Defined project name (e.g. “UBCCN” – for Upper Brushy Creek, CN method)
b. Specify description (e.g.  “Upper Brushy Creek, CN”)
c. Select “Original Stream Definition” as extraction method
d. Type something for metadata for the project
e. Select “Outside MainView Geodatabase” as project data location
f. Keep default target location
[image: ]
2) This will generate a new directory where to store the new project. 
3) Zoom in to the outlet of the dataset (most downstream DEM cell).
4) Click on “Add Project Points” GeoHSM tool ([image: ]). 
5) Click on the most downstream cell of the DEM.
a. Specify point name and description (can keep defaults)
6) Run GeoHMS “Project Setup -> Generate Project” function.
a. Verify that all input layers are pointing to the right data.  In particular the “Raw DEM”.
b. Specify output layers (can keep defaults)
7) When the watershed is delineated, say “Yes” to create the project for the area shown.  
a. Accept default names for layers that will be generated for the GeoHMS project.
b. A new data frame will be added to the ArcMap with the name of the GEoHMS project and a number of layers will be added to it.  This process can take several minutes.
c. The resulting subbasins (matching what were catchments in the Arc Hydro parent dataset) show some interesting artifacts of road system in the area.  There are some small subbasins that could be merged to the neighbors, but that is left to students to do if they choose to.
8) There are eight dams in the Upper Brushy Creek area (looking at the location of dams with the imagery base map turned on shows great level of detail).  There are several ways of adding these to the project.  Since there are not too many of them, and some of the dam points are not on the stream, manual method is presented here.  A batch point feature class is first created with correct location of selected dams using Arc Hydro “Batch Point Generation” tool ([image: ]).  This FC is developed so it can be reused later for other model alternatives.  The alternative approach is to use “Subbasin Divide” GeoHMS tool ([image: ]) and interactively divide a subbasin at dam location.
a. Prepare the map:
i. Add “Dams” layer to the map (from brushycreek_data0.gdb).
ii. Turn on labeling for the Dams layer.  Use “DAM_NAME” field as the label field.
iii. Turn on imagery.
iv. Turn on stream grid.
v. Turn on river.
b. Zoom to each dam point:
i. Click on Arc Hydro “Batch Point Generation” tool ([image: ]).
ii. Enter batch point by clicking on the nearest stream to the dam point.  When prompted to enter Name and Decript values, enter the DAM_NAME value for that point.
c. Once all the dam points have been entered, select all of them.
d. Use GeoHSM function “Import Batch Points” from “Basin Processing” menu.  Specify batch point to be “DamBatchPnt”.  All selected points will be imported into this FC.  If necessary, other points can be selected and imported as well.
e. Use GeoHSM function “Delineate Batch Points” from “Basin Processing” menu.  Specify “DamBatchPnt” as the batch point feature class.  Review results once the function is complete.  (HINT.  Simplify your map display – e.g. turn off background imagery – to speed up the processing).
f. Merge minor subbasins created when adding dam points by selecting the two (or more) adjacent subbasins and executing “Basin Processing -> Basin Merge” function.  This is personal preference (which subbasins to merge).  Good candidates are:
i. Downstream of Dam #7
ii. Upstream of Dam #1
iii. Upstream of Dam #4
iv. Upstream of Dam #13A
9) Make any other modifications as necessary.  You should merge any “tiny” subbasins as they can cause solution instability.  A good approach is to sort subbasin polygons by area size (in decreasing order) and manually inspect the smallest subbasins and merge them appropriately.  You might consider removing the most downstream subbasin from the HMS model or merging it into one of the upstream subbasins in GeoHMS.

Characterizing and parameterizing GeoHMS model
This section covers most of the exercise 6.III and IV in the H&H class materials.  
1) Select “River Length” to compute river length (populates the “RivLen” field in the stream layer).
2) Select “River Slope” to compute river slope (populates the “Slp”, “ElevUP”, and “ElevDS” fields in the stream layer).
3) Before running the “Basin Slope” function you need slope grid of the watershed.  Run the “Slope” function from “Arc Hydro Tools” -> “Terrain Preprocessing” toolset to create the slope grid (use “RawDEM” as the Raw DEM input).  Make sure you specify correct output directory (your HMS project), and use “PERCENT_RISE” as option for “Slope Type”.  If necessary, add the resulting layer into the map.  Then run “Basin Slope” to compute the average slope for the basins (populates the “BasinSlope” field in the basin layer).
4) Select “Longest Flow Path” to compute the longest flow path and flow path parameters (populates the “LongestFL”, “Slp”, “ElevUP”, “ElevDS”, “Slp1085”, “Elev10”, “Elev85”, and “LengthDown” fields in the longest flow path layer).  This function takes few minutes to complete.
5) Select “Basin Centroid” to compute basin centroids.  Use “Center of Gravity Method”.  Check if the centroid for each basin is contained within that basin.  If not, that will cause problems with GeoHMS schema generation and you will have to fix it later.  Suspect subbasins are those that have “strange” shape where the center of gravity will be outside of the polygon geometry (e.g. concave shapes).  If you do not like location of the centroid for a basin, try other methods for that basin.  (HINT.  You can just select the “offending” basin and rerun the function – the function will run on the selected set only).
6) Select “Centroid Elevation” to compute the elevation at the centroid (populates the “Elevation” field in the centroid layer).
7) Select “Centroidal Longest Flowpath” to compute the centroidal flow path.
8) Add the following data to the map:
a. UBCIMPv4.img from “Base_data” folder.
b. Curve_Number shape file from “Base_data” folder.  Run “Polygon to Raster” gp tool.  Under “Environment Settings” specify DEM (RawDEM) for the cell size, extent, and snap raster.  This will create a CN grid (you could also use the whole extent of the input layer if you are planning to later extend the area of analysis).
[image: ]
9) Select “Select HMS Processes” function from “Parameters” menu.  
a. Specify “SCS” for the Loss Method, “SCS” for the Transform Method, “None” for the Baseflow Type, and “Muskingum Cunge” for Routing Method.
10) Select “River AutoName” to generate river names.  You can modify default names if needed.  
11) Select “Basin AutoName” to generate basin names.
12) Skip functions related to ModClark (“Grid Cell Processing”).
13) Select “Subbasin Parameters from Raster” to compute the average basin curve number and percent impervious.
a. Specify UBCIMPv4.img as the “Percentage Impervious Grid”
b. Specify CNGrid as the “Curve Number Grid”.
c. Say OK to calculate the two parameters for all the subbasins.
14) Select “Muskingum-Cunge and Kinematic Wave Parameters” to assign standard Muskingum parameters to the drainage line (assign some reasonable values in the form – e.g. “Bottom Width” = 10; “Side Slope” = 3; “Manning’s N” = 0.045; “Shape” = Trapezoid).
15) Skip functions related to the rainfall and TR55 computations.
16) Select “CN Lag Method” to compute the lag based on the Curve Number method (SCS, 1973).
17) Open subbasin attribute table and calculate:
a. TotStormP = 10.2 (100-year, 24-hour depth [in] based on Austin design manual).
b. PrecipGage = “SCSTYPEII” (This will match SCS Type II temporal distribution curve.  What should be done is to develop a DSS file for a 5-minute curve based on table 2-7 in the design manual, and then reference that curve in the “PrecipGage” field).
18) Inspect all parameter values in subbasin and river feature classes.  See if there is something “wrong” or unexpected.  Make any corrections if necessary (HINT – check slopes for the river – they should not be <= 0).

Finalizing GeoHMS model development
This section covers most of the exercise 6. V in the H&H class materials.  
1) Select “Map to HMS Units” to compute the parameters in HMS units.  
a. When prompted, select unit type (e.g. “English”) and click OK.
b. Inspect basin and river feature classes and identify the fields containing the measures in specific units.
2) Select “Check Data” to generate the report if there are any problems with input data before attempting to export data to HMS.  Answer “Yes” when asked if you want to review the log file.  Review the log file and see if there are any problems.  Fix any reported problems.  If there are any problems, the most likely culprit will be centroid location that will be on the edge of the subbasin.
3) Select “HMS Schematic” to generate HMS Links and HMS Nodes.  Inspect GoeHMS schematic representation.
4) Select “Add Coordinates” to add X and Y coordinates for the links and nodes.
5) Select “Prepare Data for Model Export” to generate the HMS IDM data structure that will be used to export values to HMS.  Review some of the generated tables.  (Which tables do have entries, and which are empty?)
a. Review the values.  If not fixed problem values before, do it now it these tables.  They are the values that will be exported to HMS’ basin file.
6) Select “Background Shape File” to create the file with outline of basin and river geometry.
7) Select “Basin Model File” to create the basin file.  Both a *.basin file and an XML equivalent will be created.
8) Skip “Grid Cell File” (relevant only for ModClark processing).
9) The following process is performed to set up the meteorological model to work with the design storm (this is a new process for the new version of GeoHMS).
a. Run “Met Model File -> Specified Hyetograph”.  You will be asked to specify the name of the .met file to be created (this is a new file name – accept the default file name – this is the same name as the project name).  Once the function runs, a .met and .gage files with that name will be created (e.g. if you specify “aaa” as the name, “aaa.met” and “aaa.gage” will be created).
b. Copy file “hmsdesign.gage” from GeoHMS \bin directory (usually C:\Program Files (x86)\HEC\HEC-GeoHMS\bin) into your current GeoHMS project directory.
c. Delete the previous .gage file (e.g. “aaa.gage”).
d. Rename “hmsdesign.gage” to the old .gage name (e.g. to “aaa.gage”).
10) Run “Create HEC-HMS Project”.  
a. For “HMS Project Location”, point to the directory where you want your HMS models to reside and create a new folder to contain this model. 
b. For “Basin File”, “Met File”, and “ Gage File” specify the basin, met, and gage files created in previous steps.
c. For “HMS Run Name” specify the project name (or any other name).
d. For “Simulation Start Date Time” specify “Jan/01/2000”.
e. For “Simulation End Date Time” specify “Jan/02/2000”.
f. For “Time Interval” specify 15 minutes.
[image: ]
11) This will create a new HMS directory with GeoHMS specified project data.  Copy into that directory “hmsdesign.dss” from GeoHMS \bin directory.
12) Check the HMS project directory for created files.  Inspect their structures.

Running HMS model (CN, 100-yr, 24-hr, SCS Type II design storm)
This section covers most of the exercise 8.IV in the H&H class materials.  
1) Start HEC-HMS 3.5.
2) Click “File -> Open”.  Click on “Browse” button and navigate to the .hms file that you created at the end of exercise 6.
3) Once the project is opened, you should see entries for Basin Models, Meteorological Models, Control Specifications, and Time-Series Data HMS folders.
4) Open the basin model and review its components.  Check basin methods and their characteristics.  Verify that the GeoHMS values were correctly loaded into HMS and make any necessary modifications (HINT – check the units of the lag time for the SCS transform method).
5) Add river and subbasin background shape files.  Click “View -> Background Maps …”.  Click on “Add …” and then navigate to the HMS project directory and add the river and basin shape files (you have to do it one at the time).  Modify “Draw Properties …” of the two background layers to make the model look nice.
6) From “Compute” run “Select Run” and select the simulation run created in the previous exercise, or click on “Compute Current Run” tool on the toolbar.
7) From HMS “Compute” menu, run “Compute Run” function.
8) Review the log generated by HMS.  See if there are any reported problems.
9) Fix any problems you might encounter during the model execution.  If necessary, go back to GeoHMS and perform any necessary operations there.  Recreate required files after modifications in GeoHMS have been completed (e.g. recreate the .basin file).  If additional work is done in GeoHMS, close HMS first.
a. If you have made changes in GeoHMS and re-exported some of the files, you will have to copy them manually into the HMS directory (since those files already exist in the HMS project directory, they will not be automatically overwritten by GeoHMS).
10) Rerun HMS until a successful run is completed.
a. Go crazy with HMS options.
11) Review results using any of HMS result visualization tools.  
a. For example, select an element in HMS and from “Results” run “Element Graph”.  You should see something like in the following figure.  All the results will be saved in the model .dss file.
[image: ]

b. Display the summary table and review the peak flows for each model element.
[image: ]
c. Identify the peak flows at the outlet of the model and the junction at the upstream end of the creek reach that will be modeled with hydraulic model (e.g. Outlet = 74,706 cfs; J337 = 68,627 cfs).
12) Save project and close HEC-HMS.
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